
A.  Install Your Moulding Vendors 
 
From the Main/Menu screen, click on the Moulding button. 
2. Next, click on the Vendors button, (left). 
3. Click on the Add Vendor button, (lower left). 
4. One by one, double click on the vendors you wish to install.  
5. After all vendors have been selected, click the EXIT button    on that selection screen. 
6. Click on the Update From Web button. 
7. Type in your current Internet password then click Connect. 
8. When the update is complete, a list of companies with their new mouldings will display. 
9. Click on the Save and Exit button, (lower right). 
 

B.  Set Up Your Moulding Markup Chart 
 
At the bottom of your Add/Price Vendors screen is your Moulding Markup Chart.  
Set your sliding scale markup chart any way that you wish. 
  
1.  You can either adjust the default scale that is already set up in the system or you can set it up 
from scratch. 
2.  Set the price ranges From and To then set the times markup associated with that price range. 
3.  Once your scale is set, you will need to click on one of the Markup Buttons located in the 
bottom right hand corner of this screen.  
4.  You can set up all of your vendors with the same markup, set them all with different markups 
or you can just apply the default markup to any of your vendors. 
 

C. Install Your Mat Vendors 
 
Most of your mat vendors will automatically be installed when you install LifeSaver 
Software. Follow these instructions if you need to add any new mat vendors. 
 
1.   From the Main/Menu screen, click on the Mat button. 
2.   Next, click on the Vendors button, (left). 
3    Click on the Add Vendor button, (lower left). 
4.   One by one, double click on the vendors you wish to install.  
5. After all vendors have been selected, click the EXIT button on that selection screen. 
6. Click on the Update From Web button. 
7. Type in your current Internet password then click Connect. 



8.   When the update is complete, a list of companies with their new mouldings will display. 
9.   Click on the Save and Exit button, (lower right). 
 

D. Set Up Your Mat Markup Chart 
 
1.  You can either adjust the default scale that is already set up in the system or you can set it up 
from scratch. 
2.  Set the price ranges From and To then set the times markup associated with that price range. 
3.  Once your scale is set, you will need to click on one of the Markup Buttons located in the 
bottom right hand corner of this screen.  
4.  You can set up all of your vendors with the same markup, set them all with different markups 
or you can just apply the default markup to any of your vendors 
 

E.  Configure  
After you have installed your mat and moulding prices, you will now need to set up some 
shop and financial information. We are going to cover only the main items on this screen 
for now. Please consult your User’s Manual for more information  

1.    Go back to your Main/Menu screen. 

2.    Click on the Configure button. 

3.    Fill out your TAX information under the ‘Financial Tab’. 

   4.      PRINTING TAB (top right). Choose your Default Printer: set that a Generic. 
 
           On the bottom portion of the screen we suggest you select: 
           *  Print Tear off on Workorder 
           *  Print Framing Subtotals on Quote 
           *  Print Disclaimers on Invoice 
           *  Print Tear Off on Art Copy 
 
          Also if you need a signature copy for your business, type in ‘2’ for the number of Invoice 
copies you would like to print. 
 
   5.     Backup TAB – Type in the Drive letter and select a drive type. We suggest using a USB     
           Device. Go into My Computer to see what letter Windows has assigned to that drive.   
Next, go into Your Lifesaver program. Click on the Closing button, set the backup drive letter to 
the correct letter and set the backup type to Hard Drive. Now all of your backup files will be able 
to fit on that Thumb Drive. 
 
   6.     CMC TAB – If you use a computerized matcutter check the box for the appropriate 
cutter. 



     

 

 
 
ASSIGN PASSWORDS AND PRIVLEDGES:  
If there are certain areas of the program that you don’t want your employees to get into or if 
there are access that you can’t get into but would like to: 
1. From the Main/Menu screen, click on Configure. 
2. Click on the FILE drop down menu and select Assign Passwords. 
3. Click on the LIST button at the bottom of the screen. 
4. There you will see the Usernames that are already set up in the program. 
5. Highlight the Username you wish to adjust and press your ENTER key. 
6. In the middle of the screen are (13) buttons. These represent different parts of the program. 
7. If you needed access to the ‘Void Invoice’ option, for example, and that option was not 
available, click on the QUICKSALE button then check the box next to ‘Delete Invoice’. 
8. When finished click OK then click the Quit button to return to the Configure page. 
 
SETUP SALESPERSONS INITIALS: 
If you would like to require your sales people to enter their initials on the Invoice screen: 
1. Starting from the Main/Menu, click on Configure then click on the ‘Options’ tab. 
2. Click on ‘Require Salespersons Initials’ (right hand column). 
3. Next, click on the FILE drop-down menu from the Configure page and select Define 
Employees. 
4. Type in the Employees full name and initials then click the ADD button. 
5. Repeat this process for each employee. 
6. When finished, click Quit then click SAVE at the bottom of the Configure screen. 
 
 
 

F. Customize And Price Your Program Options 
LifeSaver allows you to customize your ticket screen options so that you can charge for the 
items you sell. In this section you can go through each category and rename items that you 
don’t use and change them to something that you will need. 
 

1.  Start at the Main/Logo screen.  
2.  Click on the Price button. 
3.  Click on the Name button next to the category you wish to modify. 
4.  Highlight any of the names that are in the list change them to whatever you need. 
5.  After you have all of the items named the way you want them, click the done button. 
6.  Repeat this process for all of your various categories, Tru Vue Glazing (Price only), Other Glass, 

Mounting, Stretching, etc. 
 



Once you have customized your program by naming all of these items, you will now go through 
and price each price card in each of these categories.  
 
To Set up new pricing: Start by clicking on the Price button next to the category you wish to 
price. Click on the File menu and select Display Cards and select the appropriate card. 

1. Click on your file menu, select Price By U.I. Enter the price per United Inches, then click OK. 
2. Do you want to replace current pricing? Click (OK). The entire chart will be filled out at once.  

 
 

To Change your prices: Start by clicking on the Price button next to the category you wish to 
price. Click on the File menu and select Display Cards and select the appropriate card.  

1. Click on the file menu and select Adjust Pricing. 
2. You can either adjust your prices or you can set a flat rate charge to your price cards. 
3. To adjust your prices, click on either raise or lower, type in the percentage amount then click 

OK. 
4. To set a flat rate charge, just type in the dollar amount into the “Set All United Inches To” field 

then click OK. 
 
There is more information concerning customization and pricing in the Price section in you 
User’s Guide. 
 
ACTIVATE 5.0 PRICING METHOD FOR SPECIALS: 
1. From the Main/Menu Screen, click on Configure. 
2. From the Configure screen click on the Options tab. 
3. Check the box to enable ‘Use 5.0 Pricing Method For Specials’. 
 
USING SPECIALS IN THE FRAMING ORDER SCREEN: 
1. From the FRAME-IT screen: 
2. Hover over any special in the list to check price appropriate for this size piece. 
3. Check the Box for a quantity of one. 
4. RIGHT CLICK on any special for multiple quantities of this same item. 
5. Price will appear in the SPECIALS box on the right side, and on the work order. 
 
ADDING A NEW SPECIAL ITEM TO THE DATABASE: 
1. From the Main/Menu, click PRICE. 
3. Click SPECIALS > PRICE. 
4. Click ADD SPECIAL. 
5. Enter a name for this new special. 
6. Select pricing method:  Square Inch, United Inch, or Per Unit 



 
7. Enter wholesale cost for this item. 
9. Enter markup factor ex: 3. 
10. (Optional) Enter minimum selling price. 
11. Select type of MATERIAL or LABOR.  
12. (Optional) Enter REMINDER MESSAGE. ex: This brass plate can have a max of 15 
characters. 
13. Click SAVE when finished. 
 
NEW GLASS ITEMS: 
If you are a long time Lifesaver customer and you were running version 4.49.0 there will be a 
change to your glass pricing and options. When you go to write a new Framing Order you will 
see (5) glass options in the middle of the Framing Order screen. The new program update 
contains all of Tru Vue’s glazing options. The Default option is CONSERVATION CLEAR. 
All of your OLD glass options and prices are still in the system. To select any of your old glass 
options, click on OTHER GLAZING and from the next window, click on OTHER (right hand 
column).  
If you need to select NO GLASS EX: Framing A Canvas, just click on the ‘Conservation Clear’ 
button on the Framing Order screen and the program will erase any glass pricing. 
If you wish to use the Tru Vue glazing option, we recommend that you; 
1. Go to the Main/Menu screen and click on PRICE.  
2. Click on the Price button on the same line as Tru Vue Glazing. 
3. Select a glazing type from the glass drop-down. 
4. Click on ADJUST PRICING and either Raise or Lower the existing prices. 
5. Do this for each of the glazing options to ensure accurate prices. 
 
 

G. Framing Orders 
 
LIFESAVER SOFTWARE VERSION 5.0 has the ability to combine your Custom Framing 
orders, Gallery items, Production pieces, Lieberman’s prints and DigitalCustom orders all on a 
single invoice. The VERSATILITY of the new SINGLE SCREEN format makes the order 
writing process easier and more efficient. Screens have changed on almost every section, but the 
FUNCTIONALITY has remained the same. In most cases the main difference will be the 
positioning of the selection buttons. Instead of being on the bottom of the screen, they will be 
along the LEFT hand side going from TOP to BOTTOM. The primary differences are discussed 
below. PLEASE READ this information if you are ready to or already have updated to Version 
5.0*.*. 
 



The 1st screen in Lifesaver will be referred to in the new documentation as the MAIN/MENU 
screen. This is the screen with all of the various buttons along the left and right hand sides. To 
begin writing any order, click the Write Invoice button. 

 
The 2nd screen will be referred to as the INVOICE screen. All orders will be written and saved 
or held from this screen. 

 
The 3rd screen will be referred to as the FRAMING ORDER screen. All Custom Framing 
orders will be written on this screen and saved to the Invoice screen. 



 
 
SPECIAL NOTE: (For Customers That Are Converting From Version 4.49.0)  
A) All of your existing WORK ORDERS and QUICKSALE items have now been assigned 
new INVOICE numbers. All NEW orders will also be assigned invoice numbers. The 
STARTING POINT for any order will be the ‘Invoice Screen’. 
   
B) If you want to find any OLD or CURRENT orders you will need to click the FIND 
BUTTON in the lower left corner of the ‘Invoice Screen’.  If you would like to find any old 
Framing Orders for either VIEWING or for creating a brand NEW order, you can still go to the 
‘Framing Order Screen’ and either BROWSE or FIND an old work order from there.  
 
C) All OLD HOLD orders can also be found from the ‘Framing Order’ screen. If you want to 
find an OLD hold order, click on the “Frame It” button from the INVOICE SCREEN, click 
BROWSE ticket, do a search using the customers LAST NAME, pull the order onto the 
Framing Order screen. Next, click on the FILE drop-down menu and select COPY Ticket then 
you can SAVE this new Framing Order to the INVOICE screen.  
 
D) DO NOT pull up an Old Invoice from the INVOICE SCREEN and then try to look up 
OTHER WORK ORDERS from the FRAMING ORDER SCREEN. You can VIEW the 
work order that is on that invoice, but you can NOT CHANGE that work order unless you want 
to do a Full Edit on that Invoice and CHANGE the framing order itself. 
 
TO BEGIN THE ORDER WRITING PROCESS:   
1. Start from the MAIN/MENU screen and click on the ‘Write Invoice’ button. 
2. This will take you to the ‘INVOICE’ screen. This was formally known as the ‘QuickSale’ 
screen. 

 
3. Type in the Customers’ LAST NAME (top right) then click on the Verify Customer button. 



4. This will BROWSE your customer files. If the customer is in the database, click on the 
customer name then click ‘Select Customer’. 
5. If they are NOT in the database, click on ‘Add Customer’. Either way, verify the customer 
record and make sure ALL of the information is entered.  
6. When complete, click on ‘Sales Screen’.  Once on the Sales Screen you have eleven line 
items per page. 
7. If you are entering a GALLERY or ART item, you can either enter the item number (if you 
have already set up your Art/Gift Inventory) or you can just type in the Quantity, Description and 
Unit Price. 
8. If you wish to create a CUSTOM FRAMING ORDER, you will click on the ‘Frame It’ 
button. This will take you to the ‘Framing Order’ screen. 
9. SAMPLE ORDER:  Tab to the IMAGE SIZE, type in a size, EX: 14.5 by 16.75. Remember 
to use your TAB key to move from field to field. 
10. Next, type in a MOULDING number in the first moulding field, EX: L335WO. 
Go to your TOP MAT WIDTH field and type in 4 then tab to the first MAT/FILLET field. 
The other sides will automatically get filled in.  
11. Type in a Mat number EX: C1609, tab then type in another Mat number, EX: C1551. 
12. Now select a REVEAL for your bottom mat.  
13. Click on the FRACTION below the second mat number and select ¼ then click OK. 
14. Type in a TITLE, W/O NOTES and ART LOCATION (optional). 
15. Select anything that you want from the SPECIALS section. 
16. Go to the OPTIONS section and select a MOUNTING and GLASS type. 
17. Click on the SAVE button (lower right). This will take you back to the ‘Invoice’ screen with 
the quantity, description, unit price and extended price filled in for that custom order.  
 
If you have MULTIPLE Custom Framing orders for the SAME customer you will follow a 
similar process. The difference is that when you click on the ‘Frame It’ button from the 
INVOICE screen, you will write up the first order and instead of clicking on the SAVE button, 
you will click on the REPEAT button.  

 
 
This will TEMPORARILY store the first order then you will be asked if you want to CLEAR 
or KEEP the information for your NEXT order. If you click on CLEAR, the Framing Order 
screen will reset to a BLANK order screen for your next order. If you click on the Keep button, 
the information from the previous order will CARRY OVER to the Next Framing order. This 
option is especially helpful when you have a number of orders that are similar. You can continue 
to use the REPEAT process for as many orders as you need. When you have completed the 
‘Last’ order, you will click on the SAVE button and then program will TRANSFER all of your 
custom framing orders on to the ‘Invoice’ screen. A LINE ITEM will be created for each order 



with all of the necessary information. The actual work order number will DISPLAY on each line 
item after the Order has been SAVED for future reference. 
   
FIND INVOICE:  
1. Starting from the Lifesaver Main/Menu screen click on Write Invoice (lower center). 
2. Click on the FIND button (lower left). 
3. Search by Work Order number, Invoice number or Last Name. 
4. Highlight the desired order then either click Continue or press your ENTER key.    
5. Once this item has been displayed, you can view work orders associated with this  invoice or 
you can EDIT the order so that you may modify the order in some way.   
 
POP-UP CALENDAR FOR DUE DATE: 
1. Starting from the Framing Order screen, click on the small drop-down arrow to the     right of 
the DUE DATE. 

 
2. A scheduling calendar will pop up. This will make it easier to select due dates.  
3. You can also click the arrows at the top of the screen to go back and forth from month to 
month. 
4. Make sure you do NOT select a day prior to the current date. 
   
EDIT ORDER:   
Once you find an existing Invoice you may Edit this invoice in a number of ways. 
A)  VIEW ORDER ONLY – This will allow you to view an existing order, but you can not 
change anything on this order or view other framing orders. 
B) EDIT WITH PRICE LOCK – This will allow you into an existing Framing Order and will 
allow you to modify the order, but the program will retain the same pricing that was on the 
original order. 
C) EDIT COMMENTS ONLY – This will allow you into the order to edit the Title or Work 
Order notes only.  
D)  INVOICE FULL EDIT – This will allow you into the order with full editing privileges. Be 
aware that the price of items on this order will change if you have updated pricing or if you 
change any of the materials on this order. After you EDIT a framing order, click SAVE to go 
back to the Invoice screen then click SAVE again to save the changes to that particular invoice. 
 
HOLD ORDERS: 
Lifesaver 5.0 has a new section specifically for HOLD orders. This will make it easier to Hold 
Orders, Save Proposals and Create new orders. You can use your hold items (especially if you do 
production work) over and over. 



1. Start by creating a Framing Order then save that order to the Invoice screen. 
2. Click on the HOLD button. (You may want to print a QUOTE before you hold). 
3. Select a Customer to assign this order to. 
4. Type in a Comment for this Hold order or Proposal then click Save.  
5. Orders are also TIME STAMPED for reference purposes. 
6. If you do a lot of Production work, you can hold any number of orders under the SAME 

Customer Name. When you retrieve that customers Hold items, you can click on as many 
items with in that “Proposal” and save them all at the same time to the INVOICE screen. 

 
HOW TO SUSPEND AN ORDER THAT IS IN PROGRESS: 
Example: If you are writing an order for a customer and they have a number of projects. If you 
need to use the computer for something else ex: To accept a payment. The Suspend/Resume 
feature will make that process more efficient. 

  
1. Start with a new Invoice then click the FRAME-IT button. 
2. Write up a Framing Order then click the Repeat button. 
3. At any time during the repeat process with as many orders as you wish, you can click the 
SAVE button and transfer the existing orders to an Invoice. 
4. Click the SUSPEND button and enter a Comment then click SAVE. 
5. Once you are finished using the computer for the other task, you can click on the RESUME 
button>Click the line item for the order that you want > Click Resume (bottom). 
6. This will take you back to the Invoice screen, so that you can continue with that same order. 
 
DELETE LINE ITEMS ON AN INVOICE: 
If you are in the process of writing an order and you need to delete a single line item from the 
Invoice screen, click on the OPTIONS button on that line item and select ‘Delete This Line 
Item’. 
 
VOID AN ENTIRE INVOICE: 
1. If you need to VOID an entire invoice, you will need to start by finding the Invoice. 
2. Start from the Invoice screen, click on the FIND button.  
3. Search by W/O number, Invoice number or Last name. 
4. Once the order is displayed, click on the FILE menu drop-down and select Void Invoice. 
 
 

 



H. Accept Payment 
 
PAYMENTS: 

1. ALL payment will be made through this payment screen. You can either click on 
Payments from the Main/Menu screen or click on the Payment button (lower right) from 
the Invoice screen. 

2. Click on ‘Only Show Customers With Balances’. 
3. Click on the Customers Last Name and select customer. 
4. Either enter the payment amount on each line item or use the Buttons at the bottom of the 

screen. 
5. Select the ‘Payment Type’. You can use the ‘Pay Half’, ‘Pay All’ or ‘Multi-Pay’ buttons 

or if you use POWER PAY you can use the Manual PP Txn button. 
6. After you have selected the payment type and amounts, click on ‘Apply Payment’. 
7. Other options on this screen are; A) Payment History – View and or Print a customers 

payment history. B) Statements – Include any and all items from past or existing orders to 
create a Statement of Account. C) Workorder Status – Check order status. Mark orders as 
Done/Delivered. 

 

 
 
 

I. Hardware Requirements And Settings 
*Windows XP Home or Professional 
* 2.0 Ghz Computer or Higher. 
* 2 Megs of Ram. 
* 17” SVGA Monitor. 
* High speed Internet Access – preferably high speed (DSL or Cable) 



* Recommended: Any HP Laser Printer 
 

Set up your Monitor Properties: Close your Lifesaver program.           
1.) Right click on a blank area of your Monitor. 2.) Select Properties. 3.) Click on the Settings 
Tab. 4.) Set your Screen Resolution to 1024 x 768. Set your Colors to 32 High Color. Click on 
the Advanced Button and set the Fonts to Small or Normal (96DPI). Click the apply button then 
click OK. Do you want to keep these settings? CLICK YES 
 

J.  Set Up Your Internet Options 
 
In order for your automatic downloads to work properly, it may be necessary to set up some 
default settings within you Internet Options section which is located in your computers Control 
Panel. 
 

1. Click on your START button on your taskbar.  
2. Select either Settings>control panel or just Control Panel. 
3. Double click on Internet Options. 
4. Click on your Connections tab. 
5. If you have a dial up connection, make sure there is a default setting for your ISP then 

make sure the button that reads, “Always Dial My Default Connection” is checked. 
6. If you have a high speed connection, click on LAN Settings and make sure that you 

check the box the reads, “Automatically Detect Settings”. 
 
If you still can’t use the automatic update feature in your LifeSaver program then you may have 
an issue with a Firewall that is installed with your computer. If it is Norton Security, you 
should be able to disable the program. Click on your START button on your TASKBAR, go to 
Programs, click on Norton Security, select OPEN then turn Norton OFF. Do your updates 
then go back in and enable Norton again. If it is one of many different types of Firewalls that is 
preventing you from doing updates, you will need to contact your System Administrator to 
allow your ISP to connect through your Firewall. 
 
 
Special Note: If you have Windows XP Service Pack II, you will need to go to 
START>Settings>Control Panel.  

1. Double click on Windows Firewall 
2. Go to the Exceptions tab and select Add Programs. 
3. Scroll down the list of programs, click on LifeSaver Software then click OK. 
4. Click on the General tab at the top of the screen and click on the ON button. 



 
If you are still having problems, you will need to call your computer or Windows support 
desk. 
 

K.  Internet Access: Download Vendor and Program Updates. 
 
Your LifeSaver Software comes with the ability to do live updates through the internet in order 
for you to get all of your vendor and program updates automatically. You have to have 
internet access on your Main LifeSaver computer. It is best if you have a high speed access 
(DSL or Cable) but you can still use a dial up service.  

1. Starting from the LifeSaver Main/Menu screen, click on the Update button at the bottom 
of the screen. 

2. Type in your internet password, this will be provided to you when you get your program 
and will be updated via e.mail when the password is changed. 

3. Check the boxes that you wish to update, Mats, Mouldings or Program updates then 
just click the Start Update button at the bottom of the screen. 

4. LifeSaver will automatically connect to your ISP. If you get a message that reads, 
“Unable to establish connection to server” or something similar, refer to section (K) 
In this manual.  

5. After your downloads are complete, you will get a Moulding review screen that will 
show you all of the changes to your moulding database. You can print out a list of all of 
your deleted mouldings. We recommend that you click on the button to remove your 
discontinued mouldings then click on the SAVE and EXIT button. 

6. Next, you will get a Mat review screen. This will give you the same type of 
information. Remove you discontinued mats then click on SAVE and EXIT. 

7. If you have checked the box to update you program files, you will be prompted to 
start your program update. Your LifeSaver program will automatically be shut down 
and you will be prompted to start your program update. Follow the prompts for your 
installation. When it is finished, LifeSaver will automatically restart. If you have a 
network of computers, all of your client computers will be automatically updated when 
you restart each one of them. Just follow the prompts to update your client computers. 

 
That’s it! Now all of your vendors are up to date and you will be running the most current 
program features. We recommend that you use you Update Center twice a month to insure all 
of your information is kept current. 
 

 
 



L.  Daily Closing Options 
 

   You should run your Daily Closing Reports every day. This section of your software will give 
you your financial information, material reports, billing statements and will allow you to 
backup your LifeSaver program to protect against the loss of any of your data. 

 
1. Starting from the Main/Logo menu screen. 
2. Click on the Closing button. 
3. From this screen you have a number of options.  
4. The options we highly recommend that you perform on a daily basis are End Of Day Reports 

and Backup. 
  
CLOSING REPORTS: 
For any customer that was using the Sales Journal for tax information, that report is no longer 
available. That has been replaced by some New Closing Reports.  
1. From the Main/Menu screen, click on CLOSING. 
2. Very much like the old closing screen, check or uncheck the boxes for the reports you wish to 
run. We recommend ‘End Of Day’ and ‘Backup’ everyday. 
3. When you click the START CLOSING button you will get a similar PREVIEW screen. This 
screen will show you only the current days’ transaction. This screen is NOT editable. If you need 
to make adjustments to your books, you will need to either run Refunds or Edit orders to adjust 
‘Payments’ or ‘Payment Types’. 
4. When you click the CONTINUE button, all of your Closing Report options will display. 
5. The Top portion shows Daily Report options and the bottom portion shows Monthly Report 
options. 
6. You can select a Date Range to print or reprint any date(s) that you wish. 
7. You can also get to the reports from the reports screen. 



 
 
A) Print Daily Detail: 
Report Summary Page – This is basically the same report as the ‘Closing Summary and Bank 
Deposit’ report that was in the previous version. 
Order Summary Report – This will give you a report on all orders written for a specific day 
regardless of payment. 
Paid In Full Report – This report is for all orders that on a specific day were Paid In Full. They 
could be paid in full on that day or they could have had prior deposits and today were now paid 
in full. 
Payment Summary Report – This report will list all payments for a specific day regardless of 
whether they were paid in full or not. 
 
B) Print Monthly Summary: 
Order Summary Report – All orders written for a specific month. For tax purposes – Use this 
report if you pay taxes on all orders written regardless of payments. 
Paid In Full Report – All orders paid in full for a specific month. For tax purposes (Accrual 
Based Accounting). Use this report if you only pay taxes on orders that are Paid In Full. This 
report would be used in place of the OLD SALES JOURNAL. 
Payment Summary Report – All payments made during a specific month. For tax purposes (Cash 
Based Accounting). These are all payments made during a specific month regardless of whether 
they have been paid in full or not. 



 
NOTE: Daily reports and Monthly Summary reports may now be run as many times during the 
day as needed. 

 
DELIVERED AND UNDELIVERED REPORTS: 

 
Lifesaver now gives you Delivered and Undelivered order reports. From your calendar you can 
still print Work Order ‘To Do’ and ‘Completed’ lists. Now when an order has been picked up by 
your customer, you can mark that order as Delivered.  
When an Invoice is Paid in Full you will have a new prompt, “Would You Like To Mark This 
Order As Delivered”. (Yes/No). Please be sure to select the appropriate option.   
If you choose ‘NO’ when the item is paid in full you can still go back and mark orders as 
delivered. 
1. From the Invoice screen, click on PAYMENT. 
2. Select a customer and bring up their account balance. 
3. Click on the Workorder Status Tab and from there you can mark orders as done and delivered.     
 

Again, thank you for choosing LifeSaver Software. You are now ready 

to start using your new program. We recommend going to your Framing 
Order Screen and start practicing with your order writing. For more 
information on all aspects of your program, please read your User’s 
Guide.   
 


